
143

Formatting Cells  
and Ranges 6

KEY TERMS
• align

• attribute

•  conditional formatting

• font

• Format Painter

• hyperlink

• merged cells

• Mini toolbar

• Paste Special

• Rules Manager

• style

• wrap

Contoso, Ltd.’s income is 

LESSON SKILL MATRIX

Skills Exam Objective Objective Number

Inserting and Deleting Cells Insert and delete cells. 2.1.6

Manually Formatting Cell Contents Modify cell alignment and indentation. 2.2.2

Change font and font styles. 2.2.3

Apply highlighting. 2.2.7

Apply Number formats. 2.2.6

Wrap text within cells. 2.2.5

Merge cells. 2.2.1

Copying Cell Formatting with the Format Painter Use Format Painter. 2.2.4

Understanding Paste Special Options

Formatting Cells with Styles Apply cell styles. 2.2.8

Working with Hyperlinked Data Insert hyperlinks. 1.2.2

Applying Conditional Formatting to Cells Apply conditional formatting. 2.3.1

Clearing a Cell’s Formatting
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generated by four physicians and a physician’s assistant (PA). Working in collabo-

ration with the physicians, the PA sees patients who need an appointment when 

all the physicians’ schedules are full. Many chronically ill patients whose condi-

tions require frequent monitoring are scheduled with the PA. Because the firm often 

experiences hectic schedules and overtime, management is considering adding a 

nurse practitioner (NP) to balance the patient load. An NP is a registered nurse who 

provides some of the same care as a physician. For instance, in most states, an NP 

can prescribe medications. In this lesson, you use Excel to manage the relevant data 

associated with Contoso’s physicians and their assistants to determine whether an 

NP should be added to the staff.

SOFTWARE ORIENTATION

Formatting Excel Worksheets

The Excel HOME tab shown in Figure 6-1 contains formatting and editing commands that 
help you enhance the appearance and readability of your worksheets. You will use commands 
from almost every group on this tab as you learn to apply formatting to data, copy formatting, 
and apply styles.

Character attributes Number formats Style commands

Text alignment commands Cell inserting, deleting,  
and formatting commands

Excel provides many ways to format text and values in a worksheet. In the business world, 
worksheets are usually printed or shared with others. Therefore, you want your worksheets to 
be as appealing and understandable as possible.

Figure 6-1

The HOME tab
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INSERTING AND DELETING CELLS

After creating a worksheet, you might decide to add more data or delete unnecessary data. Al-
though you can insert or delete entire rows and columns, sometimes you just need to work with 
a single cell or a range of cells. You can insert or delete single cells or ranges of cells, but be aware 
that doing so affects the location of other cells.

Inserting Cells into a Worksheet

When you insert a cell in a column, you force the other cells in the same column to move down. 
Inserting a cell into a row shifts the other cells in the same row to the right.

STEP BY STEP Insert Cells into a Worksheet

GET READY. Launch Microsoft Excel.

1. OPEN the 06 Patient Visits Insert Delete data file for this lesson.

2. Click in cell G5 to make it the active cell.

3. On the HOME tab, in the Cells group, click the top part of the Insert button, as shown in 

Figure 6-2. All cells in column G beginning with G5 shift down one cell.

Figure 6-2

The Insert button in the Cells 
group on the HOME tab

Insert button

4. Type 590 and press Enter.

5. Select cells O3:O9.

6. On the HOME tab, in the Cells group, click the Insert button arrow and then select 

Insert Cells.

7. In the Insert dialog box, ensure the Shift cells right option is selected, as shown in 

Figure 6-3. Click OK.

Figure 6-3

The Insert dialog box

8. Notice that the cells formerly in O3:O9 shift one cell to the right. The worksheet should 

look similar to Figure 6-4.

Bottom Line

Another Way
You can right-click 

in a cell and select Insert from 
the shortcut menu to open the 
Insert dialog box.
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Figure 6-4

The worksheet after 
inserting cells

Insert command

Cells in column G moved down

Inserted range 
of cells

9. In cell O3, type November.

10. Enter the following numbers in cells O4 through O9:

480

502

446

577

302

302

11. SAVE the workbook to your Lesson 6 folder as 06 Patient Visits Insert Delete Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

Additions and changes are common activities in Microsoft Offi ce Excel 2013 workbooks. After 
creating and saving an Excel workbook that tracks the number of patients treated monthly, the 
Contoso administrative assistant discovered that corrections were needed and additional data had 
to be added. In the previous exercise, you made the corrections and additions. You’ll use the same 
worksheet later in this lesson to determine whether to hire a nurse practitioner based on the aver-
age number of hours worked by employees. 

When you click the Insert command arrow in the Cells group on the HOME tab, the menu in-
dicates you can easily insert cells, worksheet rows, worksheet columns, or even a new worksheet 
into a workbook.

If you click the Insert button in the Cells group, a blank cell is inserted and, by default, the ex-
isting cells move down in the column. If, however, you click the Insert button arrow and select 
Insert Cells, the Insert dialog box shown in Figure 6-3 opens, and you can choose to shift cells to 
the right or down, insert a row, or insert a column in a worksheet. 

Deleting Cells from a Worksheet

When  you delete cells in a worksheet, you remove one or more cells, forcing other cells to move 
up or to the left.

STEP BY STEP Delete Cells from a Worksheet

GET READY. USE the workbook you modifi ed in the previous exercise.

1. Click cell P7 to make it the active cell.

2. On the HOME tab, in the Cells group, click the Delete button arrow, and then select 

  Delete Cells.

How do you insert cells into 
a worksheet?

2.1.6

Another Way
You can right-click 

in a cell and select Delete from 
the shortcut menu to open the 
Delete dialog box.
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3. In the Delete dialog box, select the Shift cells left option and click OK. The content in 

cell Q7 shifts to the left and appears in cell P7.  

4. Highlight the range A8:P8. 

5. Right-click the selection, which is a duplicate of the next row of data, and select Delete 

from the shortcut menu.

6. In the Delete dialog box, ensure Shift cells up is selected and click OK.

7. To delete a range of cells in a column, highlight the range D3:D8, and on the HOME 

tab, in the Cells group, click the Delete button arrow and then select Delete Cells. 

Ensure Shift cells left is selected, and click OK. The worksheet should look similar to 

Figure 6-5.

Figure 6-5

The worksheet after  
deleting cells

8. SAVE the workbook and CLOSE the file.

PAUSE. LEAVE Excel open to use in the next exercise.

When you click the arrow below the Delete command in the Cells group on the HOME tab, 
notice that you can delete a cell, a worksheet row, a worksheet column, or an entire worksheet. 

Deleting a cell is not the same as clearing a cell’s content, which you learned about in Lesson 
2, “Working with Microsoft Excel 2013.” Think of an Excel worksheet being similar to several 
stacks of boxes. The boxes are lined up alongside one another and on top of one another to form a 
grid. The open side of every box is facing you. You can take contents out of a box, thus emptying 
the box, but the box still remains in the stack. This is equivalent to clearing a cell’s content. The 
same principle applies when you press Delete on the keyboard—you’re simply removing the cell’s 
content. However, when you pull a box out of the stack, the entire box is gone. This is the same as 
deleting a cell using the Delete Cells command.

For more information about clearing a cell’s content, refer to Lesson 2.

MANUALLY FORMATTING CELL CONTENTS

Excel provides many different tools to help you format cell content. Applying formatting can 
make your worksheets easier to understand, draw attention to important information, and provide 
a professional touch. The tools you need to make your worksheets look outstanding are located in 
various groups on the ribbon’s HOME tab.

Aligning and Indenting Cell Contents

Excel enables you to align text and numbers horizontally and vertically. To align means to ar-
range in a line or bring into alignment. Horizontal alignment includes left, right, and center. 
Vertical alignment includes top, middle, and bottom. You can use Alignment commands in the 
Alignment group on the HOME tab or commands in the Format Cells dialog box to change the 
alignment of cell contents. Indentation moves cell contents closer to the right border of a cell.

How do you delete a cell 
from a worksheet?

2.1.6

Cross 
Ref

Bottom Line
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STEP BY STEP Align Cell Contents

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 06 Patient Visits Format Cells data fi le for this lesson. 

2. Select A3:O3.

Manual formatting is applied only to selected cells. Therefore, you need to select the cell or a 
range of cells before applying the formatting.

3. On the HOME tab, in the Alignment group, click the Center button, as shown in Figure 

6-6. The column labels are now horizontally centered.

Figure 6-6

The Alignment buttons 

Top Align

Center Align
Bottom Align

Align Left Center Align Right

4. Select D4:O8, and then on the HOME tab, in the Alignment group, click the   Align Right 

button. All numbers in the months columns are now right-aligned.

5. SAVE the workbook to your Lesson 6 folder as 06 Patient Visits Format Cells Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

By default, when you enter alphabetic characters or alphabetic characters combined with numbers 
or symbols, the cell content is left-aligned horizontally, which means it lines up along the left side 
of the cell. When you enter numbers, the content is right-aligned—that is, it lines up with the 
right side of the cell. When you center content, it lines up with the midpoint of a cell.

Vertical alignment affects the location of content vertically within a cell. Your options in the 
Alignment group on the HOME tab are   Top Align,   Middle Align, and   Bottom Align. You can 
also select   Justify or   Distributed, which are available in the Format Cells dialog box, shown in 
Figure 6-7. To access the dialog box, click the Dialog Box Launcher in the lower-right corner of 
the Alignment group on the HOME tab.

Figure 6-7

The Format Cells dialog box

Troubleshooting

How do you align cell 
content in a worksheet?

2.2.2

Another Way
You can access 

the Format Cells dialog box 
by right-clicking in a cell or 
on a column or row label and 
selecting Format Cells.

D4D4D4:O:O:O8, and d d d thenenen o o on n n the HOME tab, in the Alignment group
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The following describes each type of vertical alignment:

• Top (or Top Align): The top line of text appears at the top of the cell.

• Center (or Middle Align): Text is centered halfway between the top and bottom of the cell.

• Bottom (or Bottom Align): Text appears at the bottom of the cell. This is the default vertical 
alignment.

• Justify: Text is spread evenly throughout the cell. Excel will wrap text and automatically adjust 
the row height, if necessary.

• Distributed: Text is spread evenly between the top of the cell and the bottom, separated by 
blank space.

STEP BY STEP Indent Cell Contents

GET READY. USE the workbook you saved in the previous exercise.

1. Select C4:C8.

2. On the HOME tab, in the Alignment group, click the   Increase Indent button, as shown 

in Figure 6-8. The cell content moves toward the right cell border.

Figure 6-8

Indentation button options
Decrease Indent

Increase Indent

3. Click the   Decrease Indent button. The cell content moves back toward the left cell 

border.

PAUSE. LEAVE the workbook open to use in the next exercise.

Indenting data in an Excel worksheet is often performed on subordinate text to enhance readability.

Changing Text Orientation

Changing      the orientation of text can help you fi t long column or row headings into a small space 
without changing the font size or column width. You can fi nd the   Orientation tool in the Align-
ment group on the   HOME tab.

STEP BY STEP Change Text Orientation

GET READY. USE the workbook from the previous exercise.

1. Select A3:O3.

2. Click the   Orientation button to open the menu, as shown in Figure 6-9.

Another Way
You can press 

the Alt key and press H, and 
then press 6 to indent a cell’s 
content.
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Figure 6-9

The Orientation menu

Orientation button opens 
the Orientation menu

3. Select Angle Counterclockwise. The column heading labels appear angled from lower 

left to upper right within each cell.

4. Click the Orientation button, and select Angle Clockwise. The column heading labels 

appear angled from upper left to lower right.

5. Click the Orientation button, and select Vertical Text. The column heading labels 

appear in a vertical line from top to bottom.

6. Click the Orientation button, and select Rotate Text Up and then Rotate Text Down to 

see how these settings affect the text.

7. Click the Orientation button, and select Format Cell Alignment. In the Format Cells 

dialog box, in the Degrees box, enter 0 and click OK. The column heading labels return 

to their original orientation.

PAUSE. LEAVE the workbook open to use in the next exercise.

Choosing Fonts and Font Sizes

A font is a set of text properties that affect the typeface, size, and similar aspects of text. The 
default, or predefined, font for ordinary text in Excel 2013 is Calibri, 11 point. You can change 
the font for a selected cell, a range of cells, columns, rows, and even for specific characters within a 
cell. To change the font, select a new font in the Font menu in the Font group on the HOME tab. 
You can also change the size in the Font Size box or click Increase Font Size or Decrease Font Size 
until the size you want is displayed in the Font Size box. 

STEP BY STEP Choose Fonts and Font Sizes

GET READY. USE the workbook from the previous exercise.

1. Click A1.

2. On the HOME tab, in the Font group, open the Font menu and select the first option 

under Theme Fonts at the top, Calibri Light, as shown in Figure 6-10. Only the text in 

cell A1 changes to the new font.

Figure 6-10

The Font menu
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3. With cell A1 still selected, open the Font Size menu indicated in Figure 6-11. Select 18. 

The font size of the text changes to 18 point.

Figure 6-11

The font-related options in the 
Font group

Font Font 
Size

Increase Font Size

Decrease Font Size

4. Select A3:O3 and from the Font list, select Arial.

5. With A3:O3 still selected, change the Font Size to 10. The column heading labels are 

now in Arial 10-point.

6. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

Excel provides many fonts, such as Arial, Calibri, and Times New Roman, in the Font menu. To 
improve the overall design of a worksheet, the font size is usually enlarged for titles and labels.

Font size is measured in points. Each time you click Decrease Font Size or Increase Font Size, the 
size changes by a set amount that matches the size options on the Font Size list. Points refer to the 
measurement of the height of the characters in a cell. One point is equal to 1/72 inch.

In the Excel Options dialog box (select File > Options), on the General page, you can change the 
default font used in all new workbooks.

If you choose a different default font and/or font size, that font is used only in workbooks you 
create after you change the default and restart Excel. Existing workbooks are not affected.

Whenever you select text, cells, rows, or columns for formatting, you can use the   Mini toolbar, 
shown in Figure 6-12, to apply selected formatting features. The Mini toolbar is a formatting 
tool that appears above or below the shortcut menu when you right-click a cell. This unique tool-
bar provides the most commonly used formatting commands. Unlike the Quick Access Toolbar, 
which can be customized, you cannot customize the Mini toolbar.

Figure 6-12

The Mini toolbar

For more information about the Quick Access Toolbar, refer to Lesson 3, “Using Offi ce 
Backstage.”

Changing Font Color

Excel      enables you to pick from thousands of colors to apply to data in worksheets. Open the Font 
Color menu in the Font group on the HOME tab to work with theme colors and the standard 
color palette, or click More Colors to access a much wider selection of colors.

How do you change 
fonts and font sizes in 

a worksheet?

2.2.3

Troubleshooting

Cross 
Ref
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STEP BY STEP Change Font Color

GET READY. USE the workbook you saved in the previous exercise.

1. Click cell A1.

2. Open the Font Color menu, as shown in Figure 6-13, and under Standard Colors, click 

the Red color box. The text Contoso, Ltd. now has a red font color.

Figure 6-13

The Font Color palette in the 
Font group

Red color box

3. Select A3:O3, open the Font Color menu, and under Standard Colors (third from the 

right), click the Blue color box.

4. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

The most recently applied color appears on the Font Color button. To apply that color, make a 
selection and click Font Color. To apply a different text color, click the arrow next to the Font 
Color button. You can choose a theme color or a standard color. You can also click More Colors 
to open the Colors dialog box, in which you can choose from additional standard colors or create 
colors to your own specifications.

Applying Special Character Attributes

An attribute is a formatting characteristic, such as bold, italic, or underlined text. You can apply 
character attributes in Excel by selecting the data to be affected and clicking a button in the Font 
group on the HOME tab.

STEP BY STEP Apply Special Character Attributes

GET READY. USE the workbook you saved in the previous exercise.

1. Select A3:O3.

2. In the Font group, click the Bold button, and then click the Italic button, as shown in 

Figure 6-14. The column labels appear in bold and italics.

Figure 6-14

The Bold, Italic, and Underline 
buttons in the Font group

Bold Italic Underline
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3. Select A4:B8 and click the Bold button. The first and last names are now bolded.

4. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

Special character attributes provide visual appeal beyond changing the font and font size. You can 
also call attention to specific data by applying these special characteristics.

To apply underlining, click the Underline button in the Font group. You can also click the arrow 
next to the Underline button and select Double Underline from the list.

When you apply underlining to cells, only the cell contents appear underlined, as shown in Figure 
6-15. To create the appearance of a continuous rule, or underline, across the bottom of a cell, you 
need to apply a border. You’ll learn about borders later in this lesson.

Figure 6-15

Underlined cells Selecting cells and then selecting 
the Underline icon simply under-
lines content, not the cell itself.

Filling Cells with Color

When formatting worksheets, you’ll find you often want to apply a colored shading, or highlight-
ing, to the background of cells to make them stand out from the rest of the cells around them. 
Use the Fill Color tool in the Font group on the HOME tab to achieve this type of highlighting.

STEP BY STEP Fill Cells with Color

GET READY. USE the workbook you saved in the previous exercise.

1. Select A3:O3.

2. In the Font group, click the Fill Color button arrow, as shown in Figure 6-16. The Theme 

Colors and Standard Colors palettes appear. 

Figure 6-16

The Fill Color button in the 
Font group

Fill Color

3. Select the Blue, Accent 1, Lighter 80% color box, as shown in Figure 6-17. A light blue 

background is applied to the column heading row.

Another Way
You can press Ctrl 

+ B to apply boldface, Ctrl + I 
to apply italics, or Ctrl + U to 
apply underlining to selected 
text.

Cells s s wiwiwith C C Colololor
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Figure 6-17

The Blue, Accent 1,  
Lighter 80% color box in  

the Fill Color tool

4. SAVE the workbook and CLOSE the file.

PAUSE. LEAVE Excel open to use in the next exercise.

No Fill (clear) is the default background color. The color palette you used to apply font color is 
also used for background color.

Much like selecting a font color, after you select a color and apply it to a cell’s background, the Fill 
Color button takes on that color. To apply the color shown on the Fill Color button, simply make a 
selection and click the button. To apply a different fill color, click the arrow next to Fill Color and 
apply either a theme color or a standard color. You can also click More Colors to open the Colors 
dialog box and custom blend colors.

You can apply a pattern effect to cells as well as a background color. To do so, first select the range 
of cells to which you want to apply a background color with fill effects, then click the Font group’s 
Dialog Box Launcher. The Format Cells dialog box opens. Click the Fill tab. As shown in Figure 
6-18, make a selection in the Pattern Style box to add a pattern to the background color.

Figure 6-18

Add a pattern to a cell’s  
background color

Applying Number Formats

Normally, values you enter into cells are unformatted—they consist of a string of numerals. You 
should format the numbers so they are easier to read or are consistent in terms of the number of 
decimal places shown. You can use tools in the Number group on the HOME tab to apply a wide 
variety of number formats, from currency to dates and times to scientific notation.

How do you apply a 
background fill color, or 
highlighting, to cells in 

a worksheet?

2.2.7
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STEP BY STEP Apply Number Formats

GET READY. With Excel running, perform these actions:

1. OPEN the 06 Contoso Revenue data file for this lesson.

2. Ensure that Sheet1 is the active sheet.

3. Select B4:D8. This data should be formatted as General, without commas or decimal 

places.

4. On the HOME tab, in the Number group, open the Number Format menu as shown in 

Figure 6-19.

Figure 6-19

The Number Format menu

5. Select Currency. The numbers are now formatted as dollars, with two decimal places 

to represent cents.

6. With B4:D8 still selected, in the Number Format menu, select Accounting. This format 

left-aligns the dollar sign in each cell.

7. In the Number group, click the Decrease Decimal button twice to display no decimal 

places. The Increase Decimal and Decrease Decimal buttons are shown in Figure 6-20. 

The numbers are now rounded to whole dollars.

Figure 6-20

The buttons in the  
Number group

Accounting  
Number Format

Percent Style

Comma Style
Increase Decimal
Decrease Decimal

8. Click in a blank cell, such as A11.

9. Click Sheet2. 

10. Select B6:B11.

11. In the Number group, click the Comma Style button. Notice that the numbers are 

formatted with a thousands separator and two decimal places but no dollar sign.

12. With B6:B11 still selected, in the Number group, click the Accounting Number Format 

button, and then click the Decrease Decimal button twice. These actions make the 

current range consistent with the number format on Sheet1.

13. Select C6:C11.

14. In the Number Format menu, select Short Date. The dates are now displayed in the 

mm/dd/yyyy format.

Another Way
You can also apply 

number formats using the 
Format Cells dialog box. Just 
right-click a cell or range of 
cells and select Format Cells 
from the shortcut menu. In the 
Format Cells dialog box, click 
the Number tab.

How do you apply number 
formatting in a worksheet?

2.2.6
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15. Manually decrease the width of column C to eliminate extra space, similar to 

Figure 6-21.

Figure 6-21

Sheet2 after applying number 
and date formats and  

decreasing the width of 
column C

16. SAVE the workbook to your Lesson 6 folder as 06 Contoso Revenue Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

Formatting a number does not affect the value in the cell; formatting simply changes the appear-
ance of the number.

The Number Format menu contains several options that let you quickly apply common number 
formats. When you click one of these options, the active cell takes on the specified number format. 
You also can select a range of cells (or even an entire row or column) before clicking a number for-
mat option. If you select more than one cell, Excel applies the number format to all of the selected 
cells. Table 6-1 summarizes the various formats available in the Number Format menu.

Number 

Format

Description

General This is the default format that Excel applies when you enter text or a number in a cell.

Number This format is used for the general display of numbers, with two decimal places by 

default. 

Currency This format is used for general monetary values and displays the default currency symbol 

with two decimal places.

Accounting This format is also used for monetary values. Currency symbols and decimal points are 

aligned in this format.

Short Date This format displays days, months, and years in the mm/dd/yyyy style by default.

Long Date This format displays dates in a long format, such as Sunday, January 10, 2014.

Time This format applies a single format: 12:00:00 AM. If you want to choose another time 

format, you must use the Format Cells dialog box.

Percentage This format displays the number with a percent sign and two decimal places.

Fraction This format displays the number as a fraction.

Scientific This format displays numbers in exponential notation (with an E): for example, 

2.00E+05 = 200,000; 2.05E+05 = 205,000.

In most cases, the number formats provided in the Number Format menu are adequate. However, 
you may occasionally want more control over how your values appear. Excel offers control over 
number formats through the Format Cells dialog box. 

Table 6-1

Excel number format preset 
options available in the  

Number Format menu
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The Number tab of the Format Cells dialog box displays 12 categories of number formats from 
which to choose, most of which are also available from the Number Format menu. However, when 
you select a category from the list box in the Format Cells dialog box, the right side of the tab 
changes to display options.

For example, the Number category has three options that you can control:

• The number of decimal places to display

• Whether to use a thousand separator

• How to display negative numbers

Notice that the Negative Numbers list box has four choices, two of which display negative values 
in red. These choices change depending on the number of decimal places and whether you choose 
to separate thousands. Also, notice that a Sample section near the top of the dialog box previews 
how the active cell will appear with the selected number format. After you make your choices, 
click OK to apply the number format to all of the selected cells.

The number format categories that are unique to the Number tab in the Format Cells dialog box 
are described in Table 6-2.

Number 

Format

Description

Special Contains additional number formats specific to your country. In the United States, there 

are four (Zip Code, Zip Code+4, Phone Number, and Social Security Number); in 

Canada, there are two (Phone Number and Social Insurance Number); in most other 

countries, there are none.

Custom Enables you to define custom number formats that are not included in any of the other 

categories. 

Text When applied to a value, causes Excel to treat the value as text (even if it looks like a 

number). This feature is useful for items such as part numbers.

Wrapping Text in a Cell

When a cell is formatted to wrap text, data that’s too long to display within the cell’s width 
automatically displays on the next line within the cell. Wrapped text also increases row height 
automatically. If you later change the column width, the text wrapping and row height adjust 
automatically.

STEP BY STEP Wrap Text in a Cell

GET READY. USE the workbook you saved in the previous exercise.

1. Click Sheet1. Notice that the content in two cells in column A cannot be fully displayed 

because of length.

2. Click A4, and then hold down the Ctrl key and click A7. Both cells—A4 and A7—are 

selected.

3. On the HOME tab, in the Alignment group, click the Wrap Text button. The text in both 

cells wraps to a second line without affecting the column width, as shown in Figure 

6-22. Notice that the Wrap Text button takes on a green background, indicating that the 

text in the selected cells is wrapped.

Table 6-2

Additional Number format 
categories

How do you wrap text in 
a cell?

2.2.5
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Figure 6-22

The formatted worksheet with 
text wrapping

Wrapped cells

Indicates the content of  
the selected cells is wrapped

4. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

You can remove text wrapping by selecting the appropriate cell or cells and clicking the Wrap Text 
button again.

If you choose a different default font and/or font size, that font is used only in workbooks you 
create after you change the default and restart Excel. Existing workbooks are not affected.

Merging Cells and Splitting Merged Cells

Merging is a useful tool when combining data from other sources, and as a means of centering a 
heading across multiple columns. A merged cell combines two or more cells into a single cell. 
Splitting cells, or unmerging them, separates previously merged cells. The Merge & Center button 
in the Alignment group on the HOME tab provides several merge commands and the Unmerge 
Cells command.

STEP BY STEP Merge and Split Cells

GET READY. USE the workbook you saved in the previous exercise.

1. On Sheet1, select A1:D1.

2. On the HOME tab, in the Alignment group, click the main part of the Merge & Center 

button. The company name remains in a single cell, which is now centered across the 

columns.

3. Select A2:D2.

4. On the HOME tab, in the Alignment group, open the Merge & Center menu. Select 

Merge & Center. The heading remains in a single cell, which is now centered across the 

columns. This step has the same effect on A2:D2 as Step 2 had on A1:D1.

5. Select A3:D3.

6. From the Merge & Center menu, click Merge & Center.

7. Read the error message that appears and click OK.

8. Only the heading in the first column remains, which is not the effect we want. Press 

Ctrl + Z to undo the last change and restore the headings. See Figure 6-23.

Troubleshooting

How do you merge two or 
more cells in a worksheet?

2.2.1
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Figure 6-23

The formatted worksheet 
with cells in the first two rows 

merged and centered

Merged and  
centered

9. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

A merged cell is created by combining two or more horizontally or vertically adjacent cells. When 
you merge cells, the selected cells become one large cell that spans multiple columns or rows.

To split, or unmerge, cells right after merging them, press Ctrl + Z. Otherwise, open the Merge 
& Center menu and select Unmerge Cells to split merged cells. You can split cells that have been 
merged into separate cells again, but you cannot split a single worksheet cell that has not been 
merged. 

Placing Borders around Cells

You can use borders to enhance a worksheet’s visual interest and to make it easier to read. You can 
either apply Excel’s predefined border styles, or you can customize borders by specifying a line 
style and color of your choice.

STEP BY STEP Place Borders around Cells

GET READY. USE the workbook you saved in the previous exercise.

1. On Sheet1, select A3:D3.

2. On the HOME tab, in the Font group, click the Borders button arrow to open the 

Borders menu, as shown in Figure 6-24.

Figure 6-24

The Borders menu in the  
Font group

The Borders 
button  
opens the 
Borders 
menu.
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3. Select Top and Bottom Border. The selected text now has a top and bottom border.

4. With A3:D3 still selected, open the Borders menu and select More Borders.

5. In the Format Cells dialog box, click the Border tab, if necessary.

6. Click a thicker line weight, such as the fifth line in the second column under Style. Then 

click the top and bottom border lines shown in the preview to the right to apply the 

thicker line. See Figure 6-25.

Figure 6-25

Applying a border option

Selected line width style

Click both lines to 
apply the line width 
style to the top and 
bottom borders.

7. Open the Color list and under Standard Colors, select the Blue color box (third from 

right under Standard Colors), and then click the top and bottom border lines shown in 

the preview to the right to apply the color. Click OK and then click in a blank cell so you 

can view the result. See Figure 6-26.

Figure 6-26

The worksheet with a colored 
border above and below 

column heading labels

8. SAVE the workbook and CLOSE the file.

PAUSE. LEAVE Excel open to use in the next exercise.

Borders are often used to set off headings, labels, or totals.

In the Font group, the Borders button displays the most recently used border style, and the but-
ton’s name changes to that style name. Click the Border button (not the arrow) to apply that 
style, or you can click the arrow and choose a different border style. Click More Borders to apply 
a custom or diagonal border. 

On the Border tab of the Format Cells dialog box, click a line style and a color. You can select a 
border style from the presets or create a style with the line-placement options in the Border area. 
To remove a border, just click the border line in the preview pane in the Format Cells dialog box.

ne w w wididididththth s s stytytylelelele



Formatting Cells and Ranges 161

COPYING CELL FORMATTING WITH THE FORMAT PAINTER

Format Painter is a feature found in most Office applications that allows you to quickly copy 
formatting attributes that you have already applied and “paint” those attributes onto other text, 
shapes, pictures, and worksheet cells. You can use Format Painter to copy font, font size, font 
color, character attributes like bolding and underlining, alignment, indentation, number formats, 
and borders and shading. Format Painter is located in the Clipboard group on the HOME tab 
and on the Mini toolbar. 

STEP BY STEP Use the Format Painter to Copy Formatting

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 06 Contoso Painter Paste Special data file for this lesson. 

2. Click Sheet2.

3. Click in cell A5.

4. On the HOME tab, in the Alignment group, click the Center button.

5. On the HOME tab, in the Clipboard group, click the Format Painter button. The mouse 

pointer changes to a plus sign with a paint brush, as shown in Figure 6-27.

Figure 6-27

The Format Painter pointer

Format Painter
Format Painter

Mouse pointer with  
Format Painter selected

Cell with formatting 
to be copied

6. Drag over B5:C5. The formatting from A5 is applied to B5 and C5.

7. If Format Painter is still active, click the Format Painter button again or press Esc to 

turn off the Format Painter.

8. SAVE the workbook to your Lesson 6 folder as 06 Contoso Painter Paste Special 

Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

You can double-click the Format Painter if you want to apply formats to multiple selections.

UNDERSTANDING PASTE SPECIAL OPTIONS

Excel gives you another tool, called Paste Special, that enables you to control specifically what 
you want to paste after using the Copy or Cut command, such as cell content, formulas, values, 
formatting, and much more. Paste Special is available in the Clipboard group on the HOME tab, 
or in the shortcut menu that appears after right-clicking a cell.

Bottom Line

Another Way
Format Painter is 

available on the Mini toolbar 
as well as in the Clipboard 
group.

How do you use Format 
Painter to copy formatting 
from one cell to another?

2.2.4

Bottom Line
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STEP BY STEP Understand Paste Special Options

GET READY. USE the workbook you saved in the previous exercise.

1. Ensure you are on Sheet2.

2. In cell A12, type Jacobsen, Lola.

3. Select B11:C11.

4. Press Ctrl + C to copy the selection to the Clipboard.

5. Right-click in cell B12 and select Paste Special from the shortcut menu. The Paste 

Special dialog box opens, as shown in Figure 6-28.

Figure 6-28

The Paste Special dialog box

6. Select Formats and click OK. Only the formatting from B11:C11 is applied to B12:C12.

7. In B12, type 1534 and press Enter. The content is formatted the same as B11.

8. In C12, type 12/15/12 and press Enter. The content takes on the same date format as 

C11. 

9. Click in A13 and type the label Total.

10. Click in B13, and on the HOME tab, in the Editing group, click the AutoSum button, and 

press Enter. The values in B6:B12 are totaled.

11. Click in B13 and press Ctrl + C to copy the selection to the Clipboard.

12. Right-click in B14, select Paste Special, in the Paste Special dialog box, select Values, 

and then click OK. Press Esc to cancel the moving border in cell B13. Only the value of 

the formula in B13 was copied to B14, not the formula itself or any cell formatting.

13. Delete the content in cell B14. See Figure 6-29.

Figure 6-29

The worksheet after applying 
Paste Special

14. SAVE the workbook and CLOSE the file.

PAUSE. LEAVE Excel open to use in the next exercise.

With Paste Special, you select a cell or range of cells with the content or formatting you want to 
copy, issue the Copy or Cut command, and then select Paste Special. Using either the buttons in 
a menu or the Paste Special dialog box, you can choose what you want to paste into a different 
cell or range. Some of the paste options include formulas, only the values displayed as a result 
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of formulas, cell formatting, column widths, everything except cell borders, values and number 
formats, and links.

Lesson 7, “Formatting Worksheets,” covers transposing rows and columns using the Paste Special 
command.

FORMATTING CELLS WITH STYLES

Excel provides a gallery of preset cell styles you can apply to greatly enhance the appeal of your 
worksheets. You can duplicate and modify styles to create your own custom styles, and you can 
easily remove styles if you no longer want to use that particular formatting.

Applying a Cell Style

A style is a set of formatting attributes that you can apply to a cell or range of cells more easily 
than by setting each attribute individually. To apply a cell style to an active cell or range, click Cell 
Styles in the Styles group on the HOME tab, then choose the cell style that you want to apply. You 
can apply more than one style to a cell or range.

STEP BY STEP Apply Cell Styles

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 06 Contoso Cell Styles data file for this lesson.

2. Click Sheet1.

3. Select cell A1.

4. On the HOME tab, in the Styles group, open the Cell Styles menu. The Cell Styles 

gallery appears, as shown in Figure 6-30.

Figure 6-30

The Cell Styles gallery

5. In the Titles and Headings section, select the Heading 1 style to apply it to the first cell 

of the worksheet.

6. Select cell A2.

7. Open the Cells Styles gallery and in the Themed Cell Styles section, select Accent1. A 

blue background with white text is applied to cell A2.

8. Select A8:D8.

9. Open the Cells Styles gallery and in the Titles and Headings section, select Total. A thin 

blue border appears above A8:D8, and a double underline appears under the range of 

cells. Select a blank cell to see the results. See Figure 6-31.

Cross 
Ref

Bottom Line
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Figure 6-31

The worksheet with  
cell styles applied

10. SAVE the workbook to your Lesson 6 folder as 06 Contoso Cell Styles Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

Style attributes include fonts and font sizes, number formats, and borders and shading. Excel has 
several predefined styles that you can apply; you can also modify or duplicate a cell style to create 
a custom cell style.

When you point to defined styles in the Cell Styles gallery, you can see the formatting that will be 
used when you apply each style. This feature allows you to assess the formatting without actually 
applying it.

Experiment with combining styles to achieve your desired effect. For example, you can click a 
themed cell style, which will apply shading to the cell. Then, you can click Cell Styles again and 
click Heading 1, which applies a larger font size, bold, and a thick bottom border.

If you are not satisfied with a style you apply, you can use the Undo command immediately after 
applying the style, remove the style by applying the Normal style, or apply another style to the 
cell or range.

Customizing Cell Styles

You can modify an existing cell style to create a new custom style. When doing so, you can either 
add or delete style attributes.

STEP BY STEP Customize a Cell Style

USE the workbook you saved in the previous exercise.

1. On Sheet1, click A2.

2. On the HOME tab, in the Styles group, open the Cell Styles menu and select New Cell 

Style near the bottom of the menu. The Style dialog box opens.

3. In the Style name text box, enter Revenue Heading, as shown in Figure 6-32.

Figure 6-32

The Style dialog box

How do you apply cell styles 
to one or more cells in 

a worksheet?

2.2.8
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4. Click the Format button.

5. Click the Font tab, in the Font style list, select Bold Italic, and click OK.

6. Click OK to close the Style dialog box.

7. With A2 still selected, open the Cell Styles menu and click Revenue Heading to apply 

the new style, as shown in Figure 6-33.

Figure 6-33

The new style applied to the 
worksheet cell

Revenue Heading style  
applied to cell A2

Revenue 
Heading style 
in the gallery

8. SAVE the workbook  and CLOSE the file.

PAUSE. LEAVE Excel open to use in the next exercise.

In this exercise, you created a new custom style by renaming (and thus duplicating) an existing 
cell style and then modifying the style. Your custom style was added to the Cell Styles gallery.

When creating a new style based on an existing style, you can uncheck options in the Style dialog 
box that you want to remove from your new style.

To simply modify an existing style, click Cell Styles in the Styles group. When the Styles gallery 
is displayed, right-click the cell style you want to change and select Modify. The Styles dialog box 
opens with the current style name displayed but not accessible. This tells you that any changes you 
make to the style will be made to the existing style rather than a customized style.

You can delete styles from the Cells Styles gallery. Doing so also removes the style from all cells 
that are formatted with it. To remove a style from the Cell Styles gallery, right-click the style in 
the gallery and select Delete from the shortcut menu. Although you can delete most preset styles 
from the Cell Styles gallery, it’s not recommended.

You cannot delete the Normal cell style.

WORKING WITH HYPERLINKED DATA

For quick access to related information in another file or on a web page, you can insert a hyperlink 
in a worksheet cell. A hyperlink is a shortcut of sorts that enables you to navigate to a web page 
or a location in another file in just one click of the mouse. Hyperlinks enable you to supplement 
worksheet data with additional information and resources.

Inserting a Hyperlink into a Worksheet

You can add a hyperlink to your document by right-clicking a cell and selecting Hyperlink from 
the shortcut menu. 

Take Note

Bottom Line

apapapplied to cell A2
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STEP BY STEP Insert a Hyperlink in a Cell

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 06 Contoso Hyperlink data file for this lesson. 

2. Click Sheet2.

3. Click in cell A15.

4. Type Company website: and press Enter.

5. Manually widen column A until all content displays properly in cell A15.

6. Right-click cell B15 and select Hyperlink from the shortcut menu.

7. In the Insert Hyperlink dialog box, in the Address box, type http://www.contoso.com/ 

and click OK. The hyperlink appears in the worksheet, as shown in Figure 6-34.

Figure 6-34

A hyperlink inserted into a 
worksheet

Hyperlink

8. SAVE the workbook to your Lesson 6 folder as 06 Contoso Hyperlink Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

Using a Hyperlink

Using a hyperlink refers to clicking the link to navigate to the location that’s embedded in the 
hyperlink.

STEP BY STEP Use a Hyperlink

GET READY. USE the workbook you saved in the previous exercise.

1. Click the hyperlink in cell B15. Because the hyperlink points to a website, your default 

web browser opens.

2. Close the browser window.

PAUSE. LEAVE the workbook open to use in the next exercise.

Clicking a hyperlink brings you to a new location. To select the cell that contains a hyperlink, 
click and hold the mouse.

Removing a Hyperlink from a Worksheet

You can remove a hyperlink from a cell using the Remove Hyperlink command. Doing so does 
not delete the text linked to the hyperlink.

Another Way
You can open the 

Insert Hyperlink dialog box by 
clicking the Hyperlink com-
mand in the Links group on the 
INSERT tab.

How do I insert a hyperlink 
into a worksheet?

1.2.2
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STEP BY STEP Remove a Hyperlink from a Cell

GET READY. USE the workbook you worked on in the previous exercise.

1. Right-click cell B15 and select Remove Hyperlink from the shortcut menu, as shown in 

Figure 6-35. The hyperlink is removed from the URL, but the URL text remains.

Figure 6-35

The Remove Hyperlink  
menu item

Remove Hyperlink 
command

2. CLOSE the workbook without saving your changes.

PAUSE. LEAVE Excel open to use in the next exercise.

Workplace Ready

THE VERSATILITY OF HYPERLINKS
A hyperlink is typically associated with accessing a web page, but Excel provides a lot more uses 
for hyperlinks. For example, inserting a hyperlink composed of the name of a file lets you open 
the file from a worksheet. You can create a hyperlink that lets you navigate to a specific location 
within the current worksheet, based on a cell reference or a named range.

Want to set up a hyperlink that automatically opens an email window? Just use the E-mail Address 
option in the insert Hyperlink dialog box, and enter an email address and Subject line text. When 
you click the resulting hyperlink, your default email program opens automatically, enabling you 
to type a message and attach files (if you want) and then send the message.

You can insert a hyperlink directly into an Excel worksheet, or attach the hyperlink to an object, 
such as a shape, chart, or photo. 

Click an email address 
to open your email client.

Click this URL to open an external file.
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APPLYING CONDITIONAL FORMATTING TO CELLS

The Excel conditional formatting feature enables you to apply formatting according to rules. You 
can apply a single rule or multiple rules, and you can use the preset rules provided by Excel or cus-
tomize them for your particular needs. The Excel Rules Manager gives you even greater con-
trol over rules by enabling you to set the order of multiple rules, fine-tune rule settings, and more.

To apply a specific conditional format, use the Conditional Formatting menu in the Styles group 
on the HOME tab and select one of the many options provided.

STEP BY STEP Apply a Specific Conditional Format

GET READY. LAUNCH Excel if it is not already running.

1. OPEN the 06 Patient Visits Conditional Formatting data file for this lesson. 

2. Select D4:O8.

3. On the HOME tab, in the Styles group, click Conditional Formatting, and then select 

Highlight Cells Rules > Greater Than. The Greater Than dialog box appears.

4. In the Format cells that are GREATER THAN box, type 600.

5. Leave the default fill color, as shown in Figure 6-36. Click OK. Cells that contain a value 

greater than 600 are formatted with a light red background color and a dark red text 

color. This data represents the months in which the physicians were seeing more than 

the ideal number of patients.

Figure 6-36

The Greater Than dialog box 
and cells displaying conditional 

formatting

6. SAVE the workbook to your Lesson 6 folder as 06 Patient Visits Conditional Formatting 

Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

Conditional formatting is a powerful Excel feature that enables you to specify how cells that 
meet a given condition should be displayed. Thus, conditional formatting means that Excel ap-
plies formatting automatically, based on established criteria.

When you analyze data, you often ask questions, such as:

• Who are the highest performing students in the gradebook?

• Which sales representatives exceeded their sales goals and in which quarters?

• In what months were revenues highest or lowest?

Conditional formatting helps answer such questions by highlighting pertinent cells or ranges of 
cells. You can even establish multiple conditional formatting rules for a data range.

Bottom Line

How do you apply a single 
criterion for conditional 

formatting?

2.3.1
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Applying Conditional Formatting for Multiple Criteria

To see the effect of two or more criteria on a set of data, you can apply multiple conditional for-
matting rules one on top of the other. This exercise shows you how to set two different conditional 
formatting rules on the same range of data.

STEP BY STEP Apply Multiple Conditional Formatting Rules

GET READY. USE the workbook you saved in the previous exercise.

1. Select D4:O8.

2. On the HOME tab, in the Styles group, open the Conditional Formatting menu, and 

then select Highlight Cells Rules > Less Than.

3. In the Format cells that are LESS THAN box, type 300.

4. In the drop-down menu, click the Yellow Fill with Dark Yellow Text option. Click OK. 

All values of less than 300 appear with a yellow background and dark yellow text color, 

along with values over 600 indicated by a light red background and dark red text, as 

shown in Figure 6-37. 

Figure 6-37

The worksheet with two sets 
of conditional formatting 

applied

5. SAVE the workbook.

PAUSE. LEAVE the workbook open to use in the next exercise.

In this lesson’s exercises, you have worked with data related to the number of patients treated each 
month at Contoso, Ltd. The chapter-opening scenario indicated that you are trying to determine 
whether you should hire a nurse practitioner. With both sets of conditional formatting applied, you can 
see at a glance which staff members see more than 600 patients or less than 300 patients in a month.

Using the Rules Manager to Apply Conditional Formats

Excel’s Rules Manager enables you to choose from preset specific conditional formats that provide 
a visual analysis of a worksheet or selected range of data. You can apply a single rule or multiple 
rules, and you can modify preset rules to display formats however you like.

STEP BY STEP Use the Rules Manager to Apply Conditional Formats

GET READY. USE the workbook you saved in the previous exercise.

1. Select D4:O8.

2. On the HOME tab, in the Styles group, open the Conditional Formatting menu, and 

select Clear Rules > Clear Rules from Selected Cells.

3. Open the Conditional Formatting menu again and select Manage Rules. The 

Conditional Formatting Rules Manager dialog box appears.

4. Click the New Rule button. In the New Formatting Rule dialog box, select Format only 

top or bottom ranked values. The dialog box changes as shown in Figure 6-38.
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Figure 6-38

The New Formatting Rule 
dialog box

5. In the Edit the Rule Description section, click the % of the selected range checkbox.

6. Click the Format button. The Format Cells dialog box opens.

7. Click the Fill tab if it’s not already selected, and then select the light red (pink) color 

box, as shown in Figure 6-39. Click OK twice.

Figure 6-39

Selecting a background color 
for the rule

8. In the Conditional Formatting Rules Manager dialog box, click the New Rule button. 

9. In the New Formatting Rule dialog box, select Format only top or bottom ranked 

values.

10. In the Edit the Rule Description section, in the first drop-down list on the left, select 

Bottom, and then click the % of the selected range checkbox.

11. Click the Format button. 

12. In the Format Cells dialog box, click a yellow background color on the Fill tab, and then 

click OK twice. The Conditional Formatting Rules Manager dialog box should look 

similar to Figure 6-40.

Figure 6-40

The Conditional Formatting 
Rules Manager dialog box with 

two rules configured

How do you use the 
Rules Manager to apply 
conditional formatting?

2.3.1
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13. Click OK. The Rules Manager applies the rules to the selected cells, as shown in Figure 

6-41. This view enables you to see the top 10 percent and bottom 10 percent values in 

the range. 

Figure 6-41

The worksheet with the top 
10% and bottom 10% rules 

applied

14. SAVE the workbook to your Lesson 6 folder as 06 Patient Visits Conditional Formatting 

Revised Solution.

PAUSE. LEAVE the workbook open to use in the next exercise.

The Excel Rules Manager enables you to create, modify, apply, remove, and manage condition-
al formatting, including multiple criteria, all in one dialog box.

In addition, you can display the Rules Manager to see what rules are in effect for the worksheet 
and apply those rules at an appropriate time. From the Conditional Formatting Rules Manager 
dialog box, you can add new rules, edit existing rules, or delete one or all of the rules. The rules 
are applied in the order in which they are listed in the Rules Manager. You can apply all the rules, 
or you can apply specific rules to analyze the data. Formatting is visible when the Conditional 
Formatting Rules Manager dialog box is open. Thus, you can experiment with the formats you 
want to apply and the order in which they are applied.

CLEARING A CELL’S FORMATTING

Although cell formatting can greatly improve the aesthetics and readability of your worksheets, 
sometimes you may need to remove the formatting, either to start over again or to use the data in 
another worksheet. Excel makes it easy to remove formatting from a single cell, a range of cells, 
or the entire worksheet. 

STEP BY STEP Clear a Cell’s Formatting

GET READY. USE the workbook you saved in the previous exercise.

1. Select A3:O3.

2. On the HOME tab, in the Editing group, open the Clear menu, and select Clear Formats. 

The formatting for the range A3:O3 is removed.

3. In the upper-left corner of your worksheet, at the intersection of the column and row 

headings, click the Select All button, or press Ctrl+A.

4. From the Clear menu, click Clear Formats. All worksheet formatting disappears.

5. Close the workbook without saving your changes.

CLOSE Excel.

As you saw in this exercise, clearing formatting from cells or an entire worksheet does not affect 
the text, numbers, or formulas in the worksheet.

Bottom Line
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SKILL SUMMARY

In this lesson you learned how: Exam Objective
Objective 
Number

To insert and delete cells. Insert and delete cells. 2.1.6

To manually format cell contents. Modify cell alignment and indentation. 2.2.2

Change font and font styles. 2.2.3

Apply highlighting. 2.2.7

Apply Number formats. 2.2.6

Wrap text within cells. 2.2.5

Merge cells. 2.2.1

To copy cell formatting with the Format 

Painter.

Use Format Painter. 2.2.4

To use Paste Special options.

To format cells with styles. Apply cell styles. 2.2.8

To work with hyperlinked data. Insert hyperlinks. 1.2.2

To apply conditional formatting to cells. Apply conditional formatting. 2.3.1

To clear a cell’s formatting.

Knowledge Assessment

Multiple Choice

Select the best response for the following statements.

1. You want to insert a cell into your worksheet. Which command do you use? 

a. The Insert command in the Cells group on the HOME tab

b. The Format command in the Cells group on the HOME tab

c. The Format Painter command in the Clipboard group on the HOME tab

d. The Format command in the shortcut menu when you right-click a cell

2. You want to format a cell so the text is spread evenly throughout the cell, wrapping 

automatically and adjusting the row height, if necessary. Which alignment option do 

you choose?

a. Center

b. Middle Align

c. Justify

d. Distributed

3. You want to fit a long column heading into a small space without changing the font size 

or column width. Which of the following is the best choice?

a. Adjust text orientation.

b. Use the Center alignment command.

c. Use the Merge & Center command.

d. Apply a special character attribute.

4. How do you display the Mini toolbar?

a. Left-click a cell.

b. Right-click a cell.

c. Select Format > Mini toolbar.

d. Select View > Mini toolbar.

cececells s s with s s stytytytyles. Apply cececellll s stytyleles.s.s.

th h h h hypypyperererlilililinknknknkedededed d d d datatatata. Insert hypypypyperererlililinknknknks.

onditiononononal formamamamatting tototo c c cells. A. A. A. Apppppplylylyly c c conononondididitititiononononalalalal formamamamattttttininining.



Formatting Cells and Ranges 173

5. Which of the following can you not copy using Format Painter?

a. Font color

b. Bold

c. Font size

d. Cell content

6. Which Paste Special option pastes only the result of a formula rather than the formula 

itself?

a. Formulas

b. Values

c. Formats

d. Formulas and number formats

7. You don’t like the cell style you just applied. Which of the following is the least effective 

way to remove or replace the style?

a. Apply another style to the cell.

b. Use the Undo command.

c. Clear the cell’s content.

d. Apply the Normal style to the cell.

8. How do you remove a hyperlink?

a. Delete the cell.

b. Edit the cell’s style.

c. Reformat the cell.

d. Right-click the cell and select Remove Hyperlink.

9. In which group on the HOME tab is the Clear Formats command located?

a. In the Editing group

b. In the Clipboard group 

c. In the Font group

d. In the Cells group

10. Which of the following is not useful for changing the font size?

a. Font Size drop-down list

b. Increase Font Size button

c. Decrease Font Size button

d. Orientation button

True / False

Circle T if the statement is true or F if the statement is false.

T F 1. When you delete cells in a worksheet, you remove one or more cells, forcing 

other cells to move down or to the right.

T F 2. When selecting a font color, you can choose a themed color but not a standard 

color from the palette.

T F 3. When you point to defined styles in the Cell Styles gallery, you can see the 

formatting that will be used when you apply each style.

T F 4. Underlining a cell’s content is the same as adding a border.

T F 5. You can apply multiple conditional formatting criteria or rules to the same set of 

data.

T F 6. Deleting a cell is the same as clearing a cell’s content.

T F 7. A hyperlink enables you to navigate to a web page, another file, or to a specific 

location in another file. 

T F 8. Style attributes include fonts and font sizes, number formats, and borders and 

shading.

T F 9. You cannot split a single worksheet cell that has not been merged.

T F 10. After you select a color and apply it to a cell’s background, the Fill Color button 

takes on that color.

ghghghght-t-t-t-click ththththe cellllllll a a a and select Remove Hyperlink.
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Competency Assessment

Project 6-1: Apply Basic Formatting

Apply basic formatting to a worksheet listing regional sales figures for a sports equipment reseller.

GET READY. Launch Excel if it is not already running.

1. OPEN 06 Regional Sales.

2. Select A1:E1. 

3. Merge and center the worksheet title.

4. Select A2:E2.

5. Bold and center the headings.

6. Select B3:E6.

7. Apply the Currency number format.

8. Decrease the decimal places by two, so no decimal places appear.

9. SAVE the workbook to your Lesson 6 folder as 06 Regional Sales Solution. 

LEAVE the workbook open for the next project.

Project 6-2: Apply Cell Styles to a Worksheet

Total sales figures and apply styles to enhance the appearance of a worksheet listing regional sales 
figures for a sports equipment reseller.

GET READY. Launch Excel if it is not already running.

1. OPEN 06 Regional Sales Solution if it’s not already open. 

2. In cell A7, type the word Total.

3. Select B7:E7.

4. AutoSum each cell.

5. Click A1.

6. In the Cell Styles menu, apply the Title style.

7. Select A2:E2.

8. In the Cell Styles menu, apply the Accent6 style.

9. Select A3:A7.

10. Apply the 40% - Accent6 cell style.

11. Select B3:E7.

12. Apply the 20% - Accent6 cell style.

13. Select A7:E7.

14. Bold all cells in the range.

15. SAVE the workbook to your Lesson 6 folder as 06 Regional Sales Formatted Solution 

and CLOSE the file. 

LEAVE Excel open for the next project.

wowoworkrkrkrkbookokokok o o o open fofofofor ththththe e e e nextxtxtxt p p p project.
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Proficiency Assessment

Project 6-3: Format a Student List for Readability

Use a variety of techniques to improve the readability of a School of Fine Arts student list. Tech-
niques include Merge & Center, applying italics, wrapping text, and using the Decrease Decimal 
command.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 06 Fine Art. 

2. Merge and center A1:E1.

3. Apply Calibri Light, 16-point, Blue to the cell A1 content.

4. Center and italicize the content in cells A2:E2.

5. Widen column C so all text displays in its entirety.

6. Wrap the text in cell D2.

7. Decrease the width of column D to fit the longest date.

8. Format row 2 to autofit the row height.

9. Format the content in E3:E12 so that only two decimal places display.

10. Decrease the width of column E to eliminate unnecessary whitespace.

11. SAVE the workbook to your Lesson 6 folder as 06 Fine Art Solution.

LEAVE the file open for the next project.

Project 6-4: Use Pasting Techniques to Add Entries to a Worksheet 

Add rows of data to a worksheet, and use Format Painter and Paste Special to apply formatting 
and copy formulas.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 06 Fine Art Solution if it’s not already open.

2. Add two more rows of data, as follows:

First Last Discipline Enrollment Date GPA

Cassie Hicks Painting 1/14/2013

Jeff Price Computer Art 1/14/2013

3. Use the Format Painter to format cells A13:D14 in the same style as A12:D12.

4. Use the Copy command to copy the new enrollment date (1/14/2013) to replace the 

1/3/2013 dates in rows 11 and 12.

5. Use Paste Special to copy the GPA formula and number format from a cell that displays 

a GPA to the two new cells that do not have GPAs entered.

6. Modify the formula in the GPA column for Cassie Hicks to total 3.3, 3.5, and 3.7.

7. Modify the formula in the GPA column for Jeff Price to total 2.9, 3.4, and 3.5.

8. Format A2:E2 as 20% - Accent1 and reapply italics.

9. SAVE the workbook to your Lesson 6 folder as 06 Fine Art Revised Solution and CLOSE 

the file.

LEAVE Excel open for the next project.
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Mastery Assessment

Project 6-5: Create a Custom Style

Create a new style and configure its settings, apply the style, and then modify the style settings.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN a new, blank workbook.

2. Create a new cell style using your first name as the style name. Include the following 

formats in the style:

Alignment: Horizontal Center, Vertical Center

Font: Arial Narrow, 16-point, Italic

Border Style: Solid line (your choice), Bottom

Border Color: Dark Blue

Fill Color: Light Blue

Pattern Style: 6.25% Gray

3. Type your first name in cell A1 and apply the style to your name.

4. Modify the style to remove the pattern style. Widen column A, if necessary.

5. SAVE the workbook to your Lesson 6 folder as 06 My Style Solution and then CLOSE 

the file.

LEAVE Excel open for the next project.

Project 6-6: Analyze Trends in Sales

Apply conditional formatting to regional sales figures to determine dollar amounts above and 
below specific levels.

GET READY. LAUNCH Excel if it is not already running.

1. OPEN 06 Regional Sales Formatted Solution from a previous project. 

2. Use conditional formatting to indicate which sales figures exceeded $24,000.

3. Use conditional formatting to indicate, in a different color, which sales figures were 

below $20,000.

4. SAVE the workbook to your Lesson 6 folder as 06 Regional Sales Trends Solution and 

then CLOSE the file. 

CLOSE Excel.

ouououour r firfirfirfirst namamamame ininin c c celelell A1 and apply the style to your name.

 thehehehe s s stylelelele to o o o remomomomove thehehehe patatattetetetern stylelele. . . WiWiWidededen n n n cococolulululumnmnmnmn A A A, , , ififif

he w w w worororkbkbkbkbooooooook k k k totototo your r r LeLeLessononon 6 6 folder asasasas  060606 M M My Stylylyle e e SoSoSoluti


